
 

 

Custodian 
Portable Gas Detector 

 

User's Manual 
 

Quick Operating Guide 
 

To switch instrument 

on: 

Press main button. Intermittent 
beep and green LED flash 
indicates unit operational.  

Alarm: Fast flashing red LEDs and 
wailing sounder indicates gas 
hazard. 

To reset (accept) alarms: Press main button 

To switch on backlight: Press any button 

To switch instrument 

off: 
Main button &  key 
simultaneously 

To zero instrument in 

clean air: 
Press lower  key until bar on 
LCD moves from RUN to ZERO 
then push main button to 
accept. If a key symbol appears 
on the LCD a password is 
required to zero the instrument 
- section 5.5. 

 
A finger guard is available which only permits access to the 

main button &  key. This restricts access to instrument 
functions but does allow the unit to be switched on and off. 
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2. Introduction to Custodian 
    



 

 The Crowcon Custodian is a portable gas detector 
which can monitor up to four gases simultaneously. It is 
designed to be carried or worn by individuals working in 
hazardous environments such as confined spaces, and will 
give a loud audible and bright visual alarm warning when 
preset concentrations of gas are detected. 
 Detailed mechanical design features have resulted in 
an easy to service instrument with sealing to IP65. 
 The user interface has been designed to combine the 
best features of 'one button operation' for routine applications, 
with simple multi-button operation for advanced functions. 
The shape of the instrument has been designed to fit 
comfortably against the body and pose the least restriction on 
movement. It can fit in a pocket, on a belt or a chest harness. 
 The detachable battery pack can be replaced in a 
hazardous zone for round the clock operation. Rechargeable 
packs utilise environmentally friendly nickel hydride batteries 
with a life of up to 1000 charge cycles. These will power an 
instrument with one flammable sensor and three 
electrochemical sensors for 16 hours. Dry cell (disposable) 
packs are also available. 
 The sensor module can be detached and replaced for 
easy field maintenance. 
 Unique to an instrument of its size, there is an optional 
integral pump for remote sampling or 'forced diffusion'.  
 

3. Operation 
    

3.1 Switch-on Sequence 
To switch on the instrument, press the main button. 
The instrument tests all LCD segments, red alarm LEDs and 

sounder before entering Run mode. The green 'confidence' 
LED will flash and the speaker bleeps every few seconds to 
reassure users that the instrument is working and the 
environment is safe. It is now ready to be used. Note the 



 

audible bleep may be turned off using the SetCustodian 
program (section 14.4). 
 
 What if the display shows a message like 'E1'? 
E numbers indicate that the diagnostic routines have found an 
error, such as Calibration Expired. Section 10 gives further 
details. 
 

3.2 Run Mode 
The instrument displays each gas reading in turn for several 
seconds, cycling back to the first. The channel displayed is 
indicated by a bar on the LCD under the gas name on the 

label. To hold on a particular channel, press the upper  

key to select the channel of interest. Note that the Run 

indication disappears. Press the lower  key to return to 

Run mode. 
The display may be blanked by a selection in the 
SetCustodian configuration program (section 14.4). 
 

  fig 3.1 
 
The display panel shown in figure 3.1 is for an instrument with 
4 sensors fitted. The sensor 1 reading is displayed first, 
indicated by the upper cursor, showing 18.7% LEL CH4 
(methane) present. After a few seconds the cursor moves to 
the next position,  and H2S (hydrogen sulphide) ppm (parts 
per million) is displayed. A few seconds later it switches to 
sensor 3 which reads ppm CO (carbon monoxide) then to 



 

sensor 4 which displays % by volume oxygen. After 
completing this cycle, it returns to sensor 1 and repeats. 
 

3.3 Display Symbol Guide 

 Battery Low 
Accompanied by faster confidence bleeps. Indicates that 
there is less than 20 minutes battery life remaining. If 
switched off, the instrument will not allow itself to be switched 
on again in this condition. 

 Pump blocked 
Accompanied by a ticking noise. Indicates that the built-in 
pump or airway is blocked. Check that the flow adaptor and 
sample lines are free from water or dirt. Also check the sensor 
filter behind the baffle plate (fig 8.1). 
This can occur if a sampling pipe is lowered into a flooded 
cavity, as the pipe may then suck up water. It can also be 
triggered if the air intake is blocked with a finger, clothing etc. 
Once blocked, the pump will not be restarted unless the flow 
adaptor is removed and re-attached, or the instrument is 
switched off and on again. 

Password protection 
Indicates that the function being selected cannot be accessed 
without a password. This may be encountered when 
attempting to Zero, Calibrate, Set Alarm levels or turn the 
instrument off. Password entry is described in section 5.5. 

 Peak hold 
Indicates that the reading displayed is the highest level 
recorded since the instrument was switched on or reset. For 
oxygen, Peak Hold records the lowest value encountered. 
Peak Hold works for all gases simultaneously. Selection is 
described in section 5.1. 



 

TWA alarm 
Sometimes appears during alarms (section 4). 
 

4. Alarm types 
For each gas channel, there are three instantaneous alarms; 
level 1, 2 and 3. For toxic gas channels, there are also two 
time weighted average (TWA) alarms which operate at short 
term (15 minute) and long term (8 hour) exposure limits. 
Level 1 and 2 instantaneous alarms (referred to as LO and HI 
on the display label) may have their thresholds adjusted from 
the instrument keypad (section 5.4). 
All alarms may have their thresholds set via the computer 
interface (section 14.4) and the following parameters may be 
set for instantaneous alarms: 
- Normally triggered on a rising level, alarms may be set to 
trigger on a falling level as with oxygen deficiency alarms. 
- Alarms may be latching, requiring manual reset, or self 
clearing when the hazard has passed. 
- Normal alarms cannot be cleared whilst the gas hazard 
persists. It is possible to set them so they may be silenced 
(the red LEDs will continue to flash). This allows the user to 
set a 'pre-alarm' warning at a low gas level and a non-
silenceable alarm at a higher level. 
- Unused alarms may be deactivated. 
If any alarm event is triggered, the red LEDs will flash and the 
sounder will emit a loud tone. This tone is selected from a 
menu available to the SetCustodian user (section 14.4). 
The gas channel which has detected an alarm condition will 
be indicated by a flashing LCD bar below the gas name. The 
gas value of a channel in alarm will flash whilst it is being 
displayed. 
If the TWA (Time Weighted Average) symbol appears on the 
display, this indicates that the total cumulative exposure to a 
toxic gas has been reached for an 8-hour shift or a 15-minute 
'window'. Health & Safety regulations require that workers 



 

should leave the hazardous area once they have exceeded 
this dose. A TWA alarm cannot be manually reset. 
The main button may be used to silence or clear certain 
instantaneous alarms as the configuration permits. 
 

5. Keypad Functions 
5.1 Peak Hold 

 

    
   fig 5.1     fig 5.2 
 

Peak Hold mode can be selected from Run mode by pressing 

the upper  button until the bar appears under the PEAK 
HOLD label legend (fig 5.1). Press the main button to make 
the double-peak symbol appear (fig 5.2). (Pressing the main 
button again at this stage restores normal display and 

removes the symbol.) Return to Run mode or a specific 

channel with the cursor keys   . 
The instrument will now display the peak reading of any 
sensor (lowest oxygen reading) since the instrument was 
switched on. Press the main button to clear the peak readings 
to current levels. 

 

5.2 Zeroing instrument in clean air 

Press the lower  key until the bar on the LCD moves from 
RUN  to ZERO. Press the main button to accept. 
The instrument will zero its gas readings. The instrument must 
be in fresh air before performing this operation. 



 

If a key symbol appears on the LCD, a password is required 
to zero the instrument - see section 5.5. 

If E2 appears (section 10), the zero offset is too great to be 
adjusted, such as would occur with an oxygen channel in air. 

In this case, the channel should be calibrated to read 20.9 
(section 5.3) 
 

5.3  Calibrating instrument 
Ensure the instrument reads zero (except oxygen) in fresh air. 
Fit the flow adaptor as described in section 6. 

From RUN mode press the  key to progress the bar on the 
LCD to the CAL position. 

Press the  key to select the gas channel to be calibrated. 
Pass calibration gas through the flow adaptor as described in 
section 6.3. 

Press the  or  keys to adjust the reading to match the 

known gas concentration. (Pressing either cursor key   
at this stage will result in the adjustment being scrapped.) 
Press the main button to accept the new value. 
A key symbol may appear indicating that this value cannot be 
changed without a password. If so, enter the password as 
described in section 5.5. 

If E3 appears (section 10) and the display does not achieve 
the desired value, the gain is being set out of range indicating 
probable sensor failure or incorrect calibration gas. 

Press the  key to select another channel for calibration or 

the  key to step via the alarm view/change options back to 

Run mode. 

5.4 Viewing/Altering Alarm levels 

Press the  key until the SET LO function is indicated. 

Press the  key to select the channel. 
The low alarm level for that channel is now displayed and may 

be adjusted with the  /  keys. (Pressing either cursor 



 

key   at this stage will result in the adjustment being 
scrapped.) Press the main button to accept the adjustment. 
A key symbol may appear indicating that this value cannot be 
changed without a password. If so, enter the password as 
described in section 5.5. 

Press the  key to select another channel or the  key to 

step via the SET HI option back to Run mode. 

The SET HI funtion is identical in operation to  the SET LO 
function exept that it operates on the level 2 alarm. 
 

5.5 Password Entry 
Access to the functions zero, calibrate, set lo and set hi may 
be restricted by the assignment of two passwords within the 
SetCustodian configuration program (section 14.4). The 
default configuration is as follows:- 

Password 1     : ZERO 

Password 2     : ZERO, CAL, SET LO, SET HI, 

OFF 
If a protected function (eg zero, fig 5.3) is selected with the 
main button, the display is cleared and the key symbol 
appears (fig 5.4) to prompt the user to key in the relevant 

password. Enter the correct sequence of the     

keys. As each key is pressed, a small 'o' appears (fig 5.5). 
After four key entries, press the main button. The selected 
function will operate if the correct password was entered, 
otherwise a question mark appears (fig 5.6). Acknowledge the 
error by pressing the main button. 

 



 

    
   fig 5.3     fig 5.4 
 

   
   fig 5.5     fig 5.6 
 
Once a password has been successfully entered, it remains 

valid until the instrument is returned to Run mode. All 
functions protected by this password now take immediate 
effect when they are selected. 

 
6. Remote Sampling & Calibrating 
 It is often desirable to take samples from a remote 
location, such as when testing a confined space before 
entering. Also, it is necessary to sample  a source of known 
gas for calibration purposes. 
 Two Flow Adaptors are available which attach over the 
sensor grille, to allow the internal pump or a hand-held 
aspirator bulb to be used to draw remote air samples. The 
adaptor is secured with two finger screws. 
 

6.1 Pumped Instruments 



 

fig 6.1 
The internal pump switches on automatically when the Pump 
Flow Adaptor is fitted over the grille. Air is drawn in through 
the nozzle on the adaptor and exhausted through the small 
nozzle below the sensor grille. In this configuration, the 
instrument continuously samples air in its immediate vicinity. 
A sample tube may be connected to the inlet nozzle for 
remote sampling. 
Warning: the instrument senses the presence of the flow 
adaptor using a magnet moulded into the adaptor. Keep the 
flow adaptor away from cassette tapes, floppy disks etc. 
 

6.2 Diffusion Instruments 

fig 6.2 
The Calibration Flow Adaptor has an inlet and outlet nozzle 
marked by air flow direction arrows. Inlet connections are as 
for pumped instruments but the outlet must be connected to a 
hand aspirator bulb or other suitable pumping device. A 
consistent style must be adopted when using hand aspirators 
- Crowcon recommend squeezing once per second to achieve 
a flowrate of approximately 0.5 - 1 litre/min. 
This adaptor may also be used on pumped instruments in 
which case the internal pump will not run. 



 

 

6.3 Calibration Method 
Pass calibration gas through the flow adaptor from a 
regulated cylinder. Use a flowmeter and needle valve set after 
the regulator to set a flow rate of 0.5 - 1 litre/min. Pumped 
units should ideally be fed gas from an unpressurised gas 
bag.  When the calibration gas may represent a toxic risk, it is 
advisable to connect the outlet to an exhaust bag or fume 
extractor. 
Typically, calibration gas must be applied for 30 seconds or 
more before the reading stabilises to its final level. This 
reading may then be adjusted to the desired level using the 
keypad (section 5.3) or computer interface (section 14.3). 
An automatic calibrator is available to streamline batch 
calibration. 
 

7. Battery pack 
 

7.1 Changing the battery pack 

 
fig 7.1 

1. Prise the clips away from the bottom of the battery pack. 
2. Push the clips up towards the instrument to detach the 
hooks and release them from the main body. 
3. Pull the battery pack away from the instrument. 
Refit a charged pack by reversing the above procedure. 
A CommsPod may be fitted in the same way. 



 

Battery packs may be replaced in a hazardous area, but 
CommsPods may only be fitted and used in a safe area. 
 

7.2 Recharging 
Do not use the charger in a hazardous area! 
Switch the charger on. 
Place the instrument in the charger with the charging contacts 
towards the rear. 
The red LED will light whilst the instrument is undergoing fast 
charge. Full recharge from flat takes about 6 hours, during 
which it is normal for the batteries to become warm. After fast 
charging, the red LED goes out and the green LED comes 
back on: the batteries are now charged and receiving a trickle 
current. The instrument can be used immediately or left on 
charge indefinitely. 
Battery packs can be recharged on their own without being 
connected to the main instrument. 
No damage will occur if dry cell packs (7.3) are inadvertently 
placed in the charger, as no charging current will flow. 
 

7.3 Dry cell packs (non-rechargeable) 
Dry cells come in a distinctly marked battery pack to avoid 
confusion. To change batteries, detach the battery pack from 
the instrument. Using the Allen key provided, remove the bolts 
securing the battery retaining plate. Replace the spent cells 
taking note of polarity indications. 
Cells may only be replaced in a safe area! 
Use only the following battery types: 
 Duracell MN1500 LR6 
 Ever Ready Energizer LR6BA 
 Varta    4006 
The use of alternative types will invalidate intrinsic safety 
approvals. 

 
8. Sensor Replacement 
   



 

 

Remove the flow 
adaptor if fitted 
(section 6). 
Remove the baffle 
plate which is 
secured by two 
screws. The 
removable filter may 
come away with this 
component. 
Remove the five 
screws securing the 
sensor plate 
assembly and 
withdraw it from the 
instrument. 
 
 
fig 8.1 

 
Rotate the quick release fixings which retain the sensor 
mounting pcb and detach it from the sensor plate. 
Individual plug-in sensors may now be replaced as required. If 
replacing a toxic sensor, it is necessary to replace the 
associated header pcb. This is supplied with the spare sensor 
and should be fitted to the socket on the marshalling pcb 
nearest to the sensor in question. 
When reassembling, ensure that all gaskets and filters are in 
good condition and correctly fitted. 
 
 
 
 
 

9. Fixing Attachments  



 

 

A number of options are 
available when it comes to 
wearing or carrying the 
instrument.  
The standard attachment is 
the transparent belt bracket 
fitted to the rear of the 
instrument through which a 
normal trouser belt may be 
fed. 
In place of the belt bracket, 
the chest harness bracket 
may be attached. The chest 
harness is worn as shown in 
figure 9.1 
 
fig 9.1 Chest Harness 

 
 
 
A pocket clip is available for the 
front of the instrument which 
enables it to be worn as shown 
in figure 9.2. The battery pack 
fits inside the pocket so that the 
sensors face outwards. 
 
 

fig 9.2 Pocket Clip 

 
 
 

10. Troubleshooting guide 



 

Symptom Diagnosis Remedy / check 

Does not switch on battery flat recharge or 
replace battery 

Does not switch off password 
required  

alter configuration 
*  

Display blank display disabled alter configuration 
* 

No confidence 
bleep 

function disabled alter configuration 
* 

Reading when no 
gas present 

zero drifted zero instrument in 
clean air  

Unstable / 
inaccurate reading 

sensor failure recalibrate or 
replace sensor 

Does not talk with 
PC 

CommsPod 
unpowered 

connect power 

       * section 14.4 
The instrument may display the following warning codes: 

E1: Calibration Expired: indicates that the period between 
regular calibrations  has elapsed. 

E2: Zero Failed: results from attempting to zero a channel 
exposed to gas (including an oxygen channel in air). The 
function request is aborted  without effect. 

E3: Calibration Failed: the gain is being set out of range 
indicating probable  sensor failure or incorrect calibration gas. 
The gas reading is set as close to the desired level as the 
gain limiting software will allow. 

E4: Sensor Overrange (displayed in place of a legal sensor 
reading) 

E5: High/low Temperature: - gas readings may not be 
reliable at  these extremes. 

E6: Electronic Hardware Failure: - the instrument should be 
sent for repair. 
Most of these warning codes can be acknowledged (cleared) 
by pressing the main button. 

11. Limitations of Use  



 

Gas readings may not be reliable at temperatures above 50C 
or below -20C. In this case the E5 error message is displayed. 
 
Flammable gas sensors will respond to many flammable 
gases and vapours, although the calibration will be specific to 
one type. Readings may be reduced if the atmosphere is 
oxygen deficient. 
Substances containing lead, silicones or halogens may 
permanently reduce the sensitivity of flammable gas 
detectors. 
 
Toxic gas sensors may respond in varying degrees to gases 
for which the sensor is not calibrated. Cross sensitivity data is 
available from Crowcon's Sales Department. 
Reactive gases such as chlorine are adsorbed onto the 
surfaces of most materials, including sensor apertures and 
sampling equipment. This will delay the response to the gas. 
Use inert tubing such as PTFE and keep sample lines short. If 
hand aspirating, ensure that the minimum flowrate of 1l/min is 
maintained. 
 
Do not replace disposable cells in a hazardous area. 
Exchange the battery pack instead. 
 
Do not use a CommsPod in a hazardous area. 
 
 
 
 
 
 
 
 
 

12. Accessories 

  Auto calibrator 
DC0 103 Charger 



 

DC0 105 CommsPod 
DC0 101 Rechargeable battery pack 
DC0 102 Dry cell battery pack 
DC0 114 Chest harness 
DC0 104 Carry case 
  Pocket clip 
  Belt bracket 
  Carry strap 
DM0 421 Finger guard 
DC0 107 Flow adaptor - pumped 
DC0 108 Flow adaptor - diffusion 
  Water float 
  Aspirator 
  Aspirator probe 
 

 
 
13. Spares 

DM0 428 Goretex filter (5 pack) 
DM0 420 Sensor blanking plug 
  Electric pump 
DM0 403 Battery pack clip 
DE0 108 Switch membrane 
DE0 110 Flammable sensor 
DE0 111 Oxygen sensor 
DE0 112 Carbon monoxide sensor 
DE0 113 Hydrogen sulphide sensor 
DE0 114 Sulphur dioxide sensor 
DE0 115 Nitrogen dioxide sensor 
DE0 116 Chlorine sensor 
 
 

14. SetCustodian Computer interface 
 

14.1 Introduction 



 

SetCust is a Microsoft Windows based utility program for 
interfacing with a Custodian gas detector. Using industry 
standard RS232 from the PC serial port, the program allows 
full access to the instrument for routine operations such as 
calibrating and advanced funtions such as altering passwords. 
Functions and configuration options are presented with 
Windows menus and dialog boxes. 
 

14.2 Installation 
The minimum hardware requirement for SetCustodian is a 
386SX PC running Windows 3.0 or later. 
To install SetCustodian on the hard disk, insert the disk in 

drive a, click on the File menu in Program Manager, select 

Run, and type a:setup as the Command Line. Setup will 
create a directory and program group called Custodian (fig 
14.1). 
 

   fig 14.1 
 
By default, SetCustodian uses serial port COM1. If using port 
COM2, the win.ini file may be edited with Notepad such that 
the lines: 
[CUSTODIAN] 
PORT=2 
are included. Be sure to create a backup of win.ini before 
editing it! 
 
To run SetCustodian: 
Run Windows. 
Double click on the SetCustodian icon which can be found in 
the Custodian program group (fig 14.1). 



 

Ensure that the instrument is fitted with a CommsPod in place 
of the battery pack (see section 7.1 on battery pack removal). 
The CommsPod must be powered from a 12V supply such as 
the Custodian charger, and the serial  lead must be plugged 
in to the computer serial port. The intrinsic safety certification 
does not permit this operation in a hazardous area. 
Switch on the instrument. 
 

14.3 Routine Functions 
 

  
 

Select Upload from the Datalink menu - this reads the 
configuration from the instrument which is necessary to 
identify various parameters such as gas types. A table 
appears on the screen. 

Select Read Gas from the Datalink menu - current gas 
values are inserted into the table. 

To zero the instrument, select Zero from the Adjust menu - 
there is the option to zero one or all channels simultaneously. 
Ensure the instrument is in fresh air. 

To calibrate the instrument, select Calibrate from the Adjust 
menu. 
Connect a supply of calibration gas as described in section 
6.3. 
Select the gas channel and type in the known value of the 

calibration gas. Click OK when the instrument reading has 
stabilised. 
 
 
 

14.4 Configuration 
 

 
      fig 14.2 Status Bar 



 

The Status Bar (fig 14.2) indicates the relative state of three 

editions of the configuration file. The FILE version is that 

stored on computer disk, the EDIT version is that stored in 

computer RAM and the Custodian version is that stored in 
the instrument. When the program is first started, all three are 
portrayed in yellow indicating that no valid configuration 
exists. 

Upload the configuration from the Datalink menu to load all 

instrument parameters into computer RAM. (EDIT and 

Custodian items on the Status Bar turn green.) Before 
editing this configuration it is wise to save the current one to 

disk: from the Files menu select Save As... and name the file 

anyname.set. The FILE item on the Status Bar turns green 
indicating that all three editions are now the same. 
 

  fig 14.3 
 



 

This configuration may be viewed or edited by clicking on the 

Edit menu to bring up the Set Parameters dialog box fig 14.3. 
Within this box, it is possible to alter the following parameters: 

- Display mode - full or blank display 

- Alarm sound - a menu of alarm tones is available for the 

instrument's gas alarm. Click Test for a preview of the sound.  

- Logging period - see Datalogging. 

- Functions timeout - if this option is selected, instrument 
keypad functions (zero, cal, set lo, set hi) will be disabled 30 
seconds after switch-on. 

- Confidence blip - on or off (shown on). 

- Next calibrate - this option defines the period between a full 
instrument calibration, and generation of the E1 (section 10) 
Calibration Expired warning. 

- Passwords - two passwords are assigned for the restriction 
of user access to instrument keypad functions. The default 
password protection shown in fig 14.3 indicates that: 

- no password is required to turn the instrument off  
- password 2 must be entered in order to calibrate or 
change alarm levels 
- either password 1 or 2 must be entered in order to zero 
the instrument 

Click the check boxes if it is required to change this pattern of 
protection. 
Click the Password 1 or Password 2 button if it is required to 
change either key sequence. The Set Password dialog box 
appears (fig 14.4). 
 



 

  fig 14.4 
 
 
 

- Setup channels - Click the Channels button to bring up the 

Setup channels dialog box (fig 14.5) 
 



 

 fig 14.5 
 

Channel 2 setup is shown - click Next or Previous for other 
channels. 

Gas type, Range and Units are selected from pull down 
menus. 

Time Weighted Average (TWA) alarm levels for Short term 

(15 minutes) and Long term (8 hour) may be edited. These 
values only apply to toxic gas channels. 
Three instantaneous alarms are configured as shown (fig 
14.5) 

Alarm 1 is a non  Latching alarm triggered by the gas level 

Rising above 5 ppm which may be silenced. 

Alarm 2 is a Latching alarm triggered by the gas level Rising 
above 10 ppm which may not be silenced. 

Alarm 3 is not Active. 

Click Finished to close the Setup Channels box and again to 

close the Set Parameters box. 



 

If any changes have been made to the configuration, the FILE 

and Custodian items on the Status Bar turn red, indicating 
that they are now different to the current RAM edits. To 
download the new configuration to the instrument, select 

Download from the Datalink menu (Custodian item on 

Status Bar turns green). Saving the configuration to disk as 

newname.set will turn the FILE item green also. 

A printout of the configuration is available by selecting Print 

from the Files menu. 
 

14.5 Datalogging 

To access logged data from an instrument, select Upload 

Log from the Datalink menu. Save file as anyname.log. See 
LogManager section for analysis of log files. 

After uploading, select Clear Log from the Adjust menu to 
make room for new reports in the instrument. 

Set the Logging period in seconds by entering a value in the 

Set Parameters dialog box from the Edit menu. The default 
value is 60 seconds. 

 

15. LogManager Program 

Once a logged data file has been saved on disk, it may be 
analysed using LogManager. 
Launch the program by double clicking on the LogManager 
icon. 

        
Select Open Log... from the File menu. 
Select the file of interest (anyname.log) by typing the filename 

or clicking on a name from the list. Click OK. 
Data is presented graphically with an individual coloured trace 
for each gas. As the mouse pointer is moved around the 
screen, the gas level and event time are displayed in the 
upper left corner. 
Use the horizontal scroll bar to move along the time axis. 



 

Gas values are scaled according to the maximum range on 
any channel shown. In order to see detail on a low range 
channel (eg 25ppm H2S), it may be advantageous to turn off 
the traces of any high range channels (eg 500ppm CO). This 

is achieved by selecting the View menu and clicking on 
channels to turn traces on or off. 
A tabular listing of the current log file is available by selecting 

Print from the File menu. The listing is directed to the 
resident printer. 
 

15.1 Spreadsheet Files 
For detailed analysis and presentation of logged data, files 
should be converted to comma separated variable (c.s.v.) 
format and then imported into a proprietary spreadsheet 
program (eg Microsoft Excel, Lotus 123). 

Select Save as... from the File menu and save the current 
logged data as anyname.csv. By default, this selection 
converts the entire file to csv format. In some countries, 
spreadsheets have been standardised to use semi-colon 

delimited data files. In this case, select the Convert menu 

and click the semi-colon data separator check box before 
saving the file. This dialog box also enables a user to convert 
just a part of the data file by entering the start and end 
reading numbers. By default, the complete file is selected. 
 

 
 
 
 
 
 
 


